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KATA PENGANTAR

Proses pembelajaran pada Program Studi Desain Interior Fakultas Seni Rupa dan Desain Universitas
Tarumanagara memiliki sasaran dan mendorong mahasiswa untuk selalu berpikir kreatif dalam
memasuki perubahan ke era digitaliasi 4.0 yang akan dihadapi. Selain itu, mahasiswa akan terus

berkembang mengikuti dengan perubahan jaman yang ada terutama di era digital saat ini.

Modul Adobe Photoshop For Design Interior Students edisi 1 ini diharapkan dapat memperkaya
pembelajaran mahasiswa desain interior dalam melakukan proses editing digital dalam penyusunan
gambar presentasi dan portofolio desain. Modul ini disusun dengan harapan mahasiswa dapat mahir
menggunakan aplikasi Adobe Photoshop. Modul ini diharapkan dapat memotivasi mahasiswa untuk
terus belajar dan menciptakan kreatifitas yang baru. Edisi modul ajar ini diharapkan dapat terus

bertambah seiring perkembangan dunia pendidikan dan pembelajaran dalam desain.

Akhir kata, kami mengucapkan terima kasih yang sebesar-besarnya kepada semua pihak yang telah
berkontribusi dan membantu dalam penyusunan modul ini. Diharapkan dapat meningkatkan minat
dan semangat mahasiswa dalam menghasilkan karya desain kreatif di era digitaliasi di masa sekarang

dan yang akan datang.

Ketua Program Studi Desain Interior

Fakultas Seni Rupa dan Desain Universitas Tarumanagara

Maitri Widya Mutiara, S.Ds., M.M.
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SECTION 1
INTRODUCTION



Apa Itu Photoshop

Adobe Photoshop adalah sebuah software yang dikembangkan oleh Adobe
Systems. Berfungsi sebagai perangkat lunak pengolah (edit) foto atau gambar
dengan kualitas tinggi.

Adobe Photoshop ini ditujukan untuk berbagai kalangan, baik perorangan
hingga perusahaan. Pertama kali dirilis pada tahun 1990 dan hingga kini masih
terus dikembangkan.

Secara garis besar, setidaknya ada 2 sistem operasi yang mendukung Photoshop
ini, yakni Windows dan MacOS. Tapi bisa juga digunakan di sistem operasi lain
seperti Linux dengan bantuan aplikasi tertentu.

Fitur Photoshop

Dari segi fitur, tentu saja ada banyak sekali fitur yang bisa ditemukan
di software ini. Beberapa fitur tersebut yaitu,

e Menyatukan Foto: Menyatukan foto menggunakan Photoshop, sangat
mungkin dilakukan. Ada banyak tools tersedia untuk melakukan hal ini.

e Mengatur Brightness: Jika Foto terlalu gelap, Fitur Brightness dan Contrast
bisa membantu mencerahkannya, bahkan hingga puluhan persen lebih terang.

e Crop Foto: Cropping atau memotong foto juga bisa dilakukan di sini.

e Mengubah Ukuran Foto: Membuat foto 2x3, 3x4, dan lain sebagainya bisa
dilakukan dengan mudah. Cukup atur resolusinya saja, Maka Photoshop akan
menyesuaikannya secara otomatis.

e Membuat Gambar: Selain bisa mengedit, Membuat gambar di Photoshop juga
dimungkinkan. Karena tersedia beberapa tools sederhana, termasuk untuk
membuat garis.

e Rotate Foto: Memperbaiki foto terbalik atau miring.

e Mengubah Saturasi Warna: Saturasi warna memang kadang perlu diubah agar
foto jadi terlihat lebih menarik. Lewat Photoshop, Hal ini juga bisa dilakukan
dengan mudah.



e Blur Foto: Membuat foto mempunyai efek kabur di sebagian dan keseluruhan

foto.

Pengenalan Interface Photoshop

a'

New Document

Untitled-1
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Working RGB: sRGB IEC61966-2.1

Square Pixels

Interface pada photoshop

Name : Kolom untuk member nama dokumen anda.

. Present : Anda dapat mengatur panjang dan lebar dokumen atau memilih

ukuran file dokumen yang telah disediakan.
Width : Mengatur lebar dokumen
Height : Mengatur tinggi dokumen

. Resolution : Mengatur kepadatan pixel dari dokumen anda, Artinya

semakin tinggi resolution maka semakin baik gambar yang dihasilkan,
Tetapi juga akan semakin memberatkan kinerja komputer.

Color Mode : Mengatur warna dokumen, Ada beberapa pilihan warna dari
Grayscale, RGB sampai CMYK. Silahkan pilih sesuai kebutuhan anda.
Background Content : Anda dapat memilih tampilan background default
dari dokumen anda, ada 3 yaitu Putih, Hitam, dan Transparan.

Advanced Options : Pengaturan tambahan untuk color / warna atau
aspect ratio dari dokumen baru anda.



b. Palette / Panel

Tab Palette / Panel pada Photoshop

Merupakan tab yang berisi informasi tentang dokumen yang sedang aktif,
Setiap langkah saat kita melakukan editing akan terekam pada palette, Ada
banyak sekali palette/panel yang dimiliki Photoshop maka dari itu tidak semua
pallete/panel muncul di tab ini, anda dapat menampilkan atau
menyembunyikan panel sesuai keinginan anda melalui perintah Windows dan
pilih panel yang anda inginkan seperti Layer, History, Navigator, Color dan lain-
lain.



c. Tab Dokumen

Untitled-1 @ 100% (RGB/8%)

Tab Dokumen pada Photoshop

Tab Dokumen akan memberi informasi pada anda tentang dokumen yang
sedang anda aktifkan meliputi nama, berapa persen anda melakukan Zoom
Dokumen dan warna sedang anda gunakan.

d. Lembar Kerja Dokumen

Lembar kerja dokumen pada Photoshop

Lembar Kerja Dokumen adalah lembar kerja anda vyang berisi
gambar/foto, teks ataupun objek lain yang sedang anda olah, Lembar kerja ini
dapat anda perbesar atau perkecil sesuai keinginan menggunakan tool yang

berada di Toolbox, kita juga dapat mengubah tampilannya menggunakan
tombol F pada keyboard.



e. Option Bar

. R Auto-Select:  Layer Show Transform Controls

Untitled-1 @ 66.7% (Rectangle 1, RGB/8#) *

3

Option Bar pada Photoshop

Option Bar adalah menu yang muncul ketika kita memilih salah satu too/
pada Tool Box, Menu ini bertujuan untuk membantu anda melakukan
pengaturan pada tool yang anda pilih, sebagai contoh jika anda memilih
Tool “Brush” maka anda dapat memilih variant Brush dan mengatur diameter
Brush pada Option Bar ini, menu Option Bar lokasi nya ada dibagian bawah menu
bar.

Ruang Kerja dan Pengenalan Tools

a. Ruang Kerja pada Photoshop

MENU BAR TOOLS PROPERTIES

Daftar Menu Perintah Membantu memonitor dan memodifikasi pekerjaan.

TITLE BAR
;gﬁéf PANEL
Berisi alat untuk Membaptu
membuat dan memonitor dan
mengedit memodifikasi
gambar. pekerjaan.
DOCUMENT
WINDOWS

Menampilkan File
yang sedang di
kerjakan.

Ruang Kerja pada photoshop



1.1 Menu Bar

Menu Bar berisi menu File, Edit, Image. Layer, Type, Select, Filter,

View, Window, Help

Menu File berisi perintah New Document, Save, Save As, Print, dll.
Menu Edit berisi perintah Cut, Copy, Paste, Transform ( Rotate, Scale,
Distort, Flip), dll.

Menu Image berisi perintah Adjustment ( Brightness/Contrast, Level,
Curve, Vibrance, Hue/Saturation), Image Size, Canvas Size, dll.

Menu Filter berisi Filter Gallery, Blur, Distort, Noise, Sharpe, dll.

Menu Window membatu mengeluarkan Tittle Bar Panel.

1.2 Perintah Dasar

Membatalkan Perintah Satu Langkah (Undo) : CTRL + Z

Membatalkan Perintah Undo (Redo) : CTRL+Z 1x lagi setelah CTRL+Z
pertama

Membatalkan Perintah beberapa Langkah : CTRL + ALT + Z atau
menggunakan Panel History (bila tidak ada, klik Menu Windows, pilih

History).

1.3 Menu Edit

o Undo Edit Type Layer Ctrl+Z
Redo Shift+Ctrl+Z
L Toggle Last State Alt+Ctrl+Z
& Fade. Shift+Ctrl+F
o : Cut Ctrl+X
3 Copy Ctrl+C
Copy Merged Shift+Ctrl+C
Paste Ctrl+V
Paste Special
Clear
Search Cil+F

Check Speling...
Find and Replace Text...

Shift+F5

Scale  Alt+Shift+Ctrl+C

Ctrl+T

Defin

Purge

Adobe PDF Presets...
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Auto-Align Layers...

Auto-Blend Layers...

Define Brush Preset...
Define Pattern...

Define Custom Shape...
Purge 4

Adobe PDF Presets...

Presets >
Remote Connections...

Color Settings... Shift+Ctrl+K
Assign Profile...

Convert to Profile...

Keyboard Shortcuts...  Alt+Shift+Ctrl+K
Menus... Alt+Shift+Ctrl+M
Tnnlhar

Menu Edit pada photoshop

Again Shift+Ctrl+T

Scale
Rotate
Skew
Distort

Perspective

Warp

Split Warp Horizontally
Split Warp Vertically
Split Warp Crosswise

Remove Warp Split
Rotate 180°

Rotate 90° Clockwise
Rotate 90° Counter Clockwise

Flip Horizontal
Flip Vertical




Perintah yang umum digunakan pada menu edit diantaranya,

- Cut, Copy, Paste

- Paste Special (Paste Into) : hasil paste dilengkapi dengan masking

- Transform

Note : Untuk Transform Scale dan Rotate, gunakan SHIFT agar gambar

tidak stretch.

Gambar Asli

1.4 Menu Image

Hasil Transform tanpa
menggunakan tombol SHIFT

Image Layer Type Select Filter 3

Mode

Adjustments

Auto Tone Shift+Ctrl+L
Auto Contrast  Alt+Shift+Ctrl+L
Auto Color Shift+Ctrl+B
Image Size... Alt+Ctrl+I
Canvas Size... Alt+Ctrl+C

Image Rotation
Crop

Trim...

Reveal All

Duplicate...
Apply Image...
Calculations...

Variables
Apply Data Set...

Trap...

Analysis

»

>

»

Menu Image pada Photoshop

Perintah yang umum digunakan pada
Adjustments, Auto Tone, Auto Contrast, Auto Color, Image Size, Canvas

Size dan Image Rotation.

menu

Image adalah



1.5 Adjusments

Image Layer Type Select Filter 3D View Window Help

— ’ Transform Controls — Lk = =
Brightness/Contrast...

] Levels... Ctrl+L
Auto Tone Shift+Ctrl+L Curves... Ctrl+M
Auto Contrast  Alt+Shift+Ctrl+L

. Exposure...
Auto Color Shift+Ctrl+B

) Vibrance...
ez Slz.e... RS Hue/Saturation... Ctrl+U
Canvas Size... Alt+Ctrl+C Color Balance... Ctrl+B
EsqElie * Black & White... AltsShift+Ctrl+B
(_r-cp Photo Filter...
Houi Channel Mixer...
Reveal AN Color Lookup...
2l i Invest Ctrl+|
Apply Irr'1age... Posterize...
Calculations... Threshold..
Variables »  Gradient Map...
Apply Data Set... Selective Color...
Trap... Shadows/Highlights...
HDR Toning...

Analysis »

Menu Adjustment padé PHotoshop

Perintah yang umum digunakan yaitu,

Levels : memperbaiki shadow atau highlight

. Brightness/Contrast : seperti level, namun hasilnya kurang akurat
dibanding level.

Curves : Pengaturan tingkat Cahaya suatu gambar dengan kurva
Vibrance : untuk mengurangi saturation

Hue / Saturation : Hanya parameter saturation yang digunakan
(interior)

Photo Filter : member filter warna pada gambar

Invert : mengubah warna gambar ke warna lawannya, misalnya
warna hitam menjadi putih

Threshold : misalnya warna hitam menjadi putih

Desaturate : mengubah gambar menjadi hitam putih secara
otomatis.



1.6 Menu Filter

Last Filter Alt+Ctrl+F

Convert for Smart Filters

Filter Gallery...

Adaptive Wide Angle...  Alt+Shift+Ctrl+A
Camera Raw Filter... Shift+Ctrl+A
Lens Correction... Shift+Ctrl+R
Liquify... Shift+Ctrl+X
Vanishing Point... Alt+Ctrl+V

3D

Blur
Blur Gallery
Distort
Noise
Pixelate
Render
Sharpen
Stylize
Video
Other

v v v Vv v Vv Vv v v v Vv

Menu Filter pada Photoshop

Perintah yang umum digunakan vyaitu Filter Gallery, Blur (Gaussian,
Motion, Radial), Blur Gallery (Iris, Tilt, Spin), Sharpen (Unsharp Mask).

1.7 Layer

.l

Tumpukan plastik transparan bergambar

Layer dapat dibayangkan sebagai tumpukan plastic transparan
bergambar yang membentuk suatu gambar baru. Kelemahannya
adalah semakin banyak layer maka data akan semakin besar dan berat.



Untuk menggambukan dua buah layer (CTRL+E) dan Untuk
menggabungkan lebih dari dua layer ( CTRL+SHIFT+E).

1.8 Layer Panel

Opacity/Transparansi

Blending Modes ke lty{rayer i

Fill Opacity

Image Thumbnail . 1 Background copy

Active Layer

Visibility +=y | Background (highlighted in blue)
Link Layers Delete Layer
Layer Effects New Layer

Layer Mask Layer Adjustment

1.9 Blending Modes

Uinear Dodge (Add)
Lighter Coloe

Soft Light

Hard Light

Vivid Light "
Linzar Light Gambar Asli
Pin Light

Hard Mix

Blending Modes berguna untuk memberi efek-efek visual serta
mengubah pencahayaan dan warna pada layer.

10



b. Tools beserta fungsi pada Photoshop

Move Tool —] b Q ——Zoom
Hand — 2 / —— Eyedropper
Marquee Selection Tools — il \}:‘ ——Lasso Selection Tool
Magic Wand Selection — "\ ¥ ||—Sselection Brush
Type Tool —| |T, ¥ |—Crop Tool
Cookie Cutter — .3’ & |—Red Eye Remover
Healing Brush —| ¢, %2, |— Stamp
Pencil — » 4 |-—Eraser
Paint Brush —| &, & |[——Paint Bucket
Gradient — g D ——Shape

Smudge, Shapren —| ﬂ o, ——Dodge and Burn
and Blur Tools 4

.'“ Foreground
Black and White ——and Background

(default color well) — 1™ Color Well
=]

Fungsi Tools — tools pada photoshop

« Move Tool

Tool ini digunakan untuk menggeser suatu objek gambar berupa layer
atau hasil seleksi, ke bidang yang sama atau ke bidang kerja lain.

« Rectangular Marquee Tool

= Tool ini digunakan untuk memilih bagian gambar atau seleksi bagian
Bl gcambar berbentuk persegi empat.

o Elliptical Marquee Tool

P Tool ini digunakan untuk membuat seleksi berbentuk lingkaran atau
W oval.
« Magnetic Lasso Tool

EP Tool ini digunakan untuk membuat seleksi pada objek yang memiliki
8 bentuk tidak beraturan.

11



« Polygonal Lasso Tool

ﬂ Tool ini digunakan untuk membuat seleksi dengan bentuk polygon
yaitu objek yang memiliki banyak sudut.

« Lasso Tool

Tool ini digunakan untuk menyeleksi semua objek secara tidak
beraturan.

« Magic Wand Tool

Tool ini digunakan untuk membuat seleksi pada objek menurut
@ kesamaan warna dengan hanya sekali klik saja.

« Quick Selection Tool

5 Tool ini digunakan untuk menyeleksi secara cepat pada objek yang
@ Sama menurut warna.

« Crop Tool

Tool ini digunakan untuk memotong atau mengambil sebagian
@ gambar atau objek yang kita inginkan.

« Spot Healing Brush Tool

¥ 4 Tool ini digunakan untuk menghilangkan atau menyamarkan noda
. pada kulit yang menggangu, seperti tahi lalat atau jerawat yang ada di
muka.

 Healing Brush Tool

P 2 Tool ini digunakan untuk menghilangkan noda yang aada pada wajah
atau kulit dengan cara menyamarkan dengan berpatokan pada kulit
yang menurut kita lembut atau halus.

12



« Patch Tool

Tool ini digunakan untuk menghilangkan objek atau noda pada
B gambar atau objek tana meninggalkan bekas dengan cara menggeser
bagian gambar hingga tertutup.

 Red Eye Tool

Tool ini digunakan untuk menormalkan mata yang berwarna merah,
@ biasanya ini ditemukan karena efek blitz, Kembali menjadi warna
hitam.

« Clone Stamp Tool

Tool ini disebut juga stempel cloning yaitu yang digunakan untuk
# membuat duplikasi suatu objek menjadi dua atau bisa lebih.

o Pattern Stamp Tool

3 Tool ini disebut juga stempel objek yaitu digunakan untuk membuat
stempel pada objek dengan bermacam — macam bentuk dan pola.

« Eraser Tool

H Dari namanya saja kita sudah kenal. Tool ini digunakan untuk
menghapus objek yang tidak kita inginkan.

« Magic Eraser Tool

Tool ini digunakan untuk menghapus suatu objek dengan cepat dan
.,
% singkat berdasarkan warna yang sama, seperti background.

13



« Background Eraser Tool

Tool ini digunakan untuk menghapus background suatu gambar tanpa
- menghapus objek utamanya.

« Smudge Tool

n Tool ini digunakan untuk memberi efek seperti menggosokkan jari
pada pewarna yaitu membuat warna bisa menjadi lebih merata.

e Blur Tool

n Tool ini digunakan untuk membuat objek menjadi kabur atau tidak
tajam.

« Sharpen Tool

Tool ini kita gunakan untuk membuat objek menjadi lebih tajam.
B Kebalikan dari blur tool. Untuk contoh kita bisa mempertajam bentuk
bibir.

e Burn Tool

ﬂ Tool ini digunakan untuk membuat warna pada objek menjadi lebih
matang dan gelap. Kita bisa mencobanya dengan menggelapkan alis
mata kita.

« Dodge Tool

-

Tool ini digunakan untuk membuat warna objek menjadi lebih cerah.

14



« Sponge Tool

Tool ini kita gunakan untuk mengubah tingkat atau derajat kejenuhan
<o
@ warna gambar.

e Brush Tool

Tool ini kita gunakan untuk membuat gambar suatu objek secara
=4
# abstrak seperti saat kita menggunakan kuas.

« Color Reflacement Tool

S Tool ini digunakan untuk mengganti warna suatu objek tanpa
P-4
@ mengubah struktur objek tersebut.

« Mixer Brush Tool

Tool ini kita gunakan untuk mensimulasikan teknik melukis realistik
Wbl seperti pencampuran warna pada kanvas.

« Gradient Tool

Tool ini bisa kita gunakan untuk membuat background dengan warna
@ gradiasi.

« Paint Bucket Tool

Tool ini kita gunakan untuk mengubah atau memberi warna pada
. background atau obijek.

« Art History Brush Tool

Gy, Tool ini digunakan untuk membuat warna abstrak yang dihasilkan dari
el warna gambar tersebut.

15



e History Brush Tool

% Tool ini kita gunakan untuk mengembalikan suatu objek yang sedang
=4 kita edit dengan brush atau terhapus dengan eraser tool ke bentuk
semula.

e Pen Tool

Tool ini digunakan untuk menyeleksi suatu bentuk objek yang banyak
# |ekukan. Contohnya kita menyeleksi seseorang.

 Freeform Pen Tool

;"8 Toolini digunakan untuk membuat jalur garis path atau bentuk vector
dengan mudah yaitu dengan kita menambahkan jangkar point secara
otomatis.

« Add Anchor Point Tool

+g Tool ini digunakan untuk menambah atau menggeser titik acuan saat
“* 'menggunakan pen tool.

« Delete Anchor Point Tool

@~ 8 Tool ini digunakan untuk mengurangi atau menghapus titik seleksi
pada saat menggunakan pen tool.

« Convert Point Tool

Tool ini bisa kita gunakan untuk mengedit posisi titik jangkar dan
8 |engkungan jalur garis path pada saat menggunakan pen tool.

16



« Path Selection Tool

RS Tool ini digunakan untuk memindahkan hasil seleksi dan menyesuaikan

L lengkungan garis seleksi pada saat menggunakan pen tool.

 Direct Selection Tool

RN Tool ini fungsinya sama dengan path selection tool yaitu untuk
L memindahkan posisi seleksi dan menyesuaikan lengkungan garis pada

saat kita menggunakan pen tool.

« Horizontal Type Tool

Tool ini bisa kita gunakan untuk membuat teks secara horizontal.

« Vertical Type Tool

Tool ini bisa kita gunakan untuk membuat teks secara vertical.

« Horizontal Type Mask Tool

E Tool ini digunakan untuk membuat seleksi teks secara horizontal.

« Vertical Type Mask Tool

E Tool ini digunakan untuk membuat seleksi teks secara vertical.

 Rectangle Tool

Tool ini digunakan untuk membuat objek persegi empat.

17



« Ellipse Tool

Tool ini bisa kita gunakan untuk membuat objek berbentuk oval atau
bulat.

e Line Tool

Tool ini kita gunakan untuk membuat objek garis.

« Polygon Tool
Tool ini digunakan untuk membuat objek persegi dengan banyak sudut.

« Custom Shape Tool
Tool ini digunakan untuk membuat aneka ragam bentuk.

« Eyedropper Tool

. Tool ini digunakan untuk mengambil contoh (sample) warna pada
gambar, Misalnya untuk mengetahui warna baju.

« Color Sampler Tool

&8 Tool ini digunakan untuk mengetahui informasi campuran warna yang
- digunakan baik itu dalam RGB atau CMYK

-

e Ruler Tool

ﬂ Tool ini digunakan untuk mengetahui jarak antara dua titik pada
gambar.

18



 Note Tool
=] Tool ini bisa kita gunakan untuk memberi catatan pada gambar.
« Hand Tool

Tool ini digunakan sebagai alat bantu untuk menggeser tampilan
gambar pada area kerja.

« Zoom Tool

Tool ini digunakan sebagai alat bantu untuk memperbesar atau
Q memperkecil tampilan gambar pada area gambar kerja.

ltulah tool-tool yang berada pada toolbox photoshop beserta fungsinya.
Selanjutnya silahkan coba cara — cara menggunakan masing - masing tools yang
diatas.
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SECTION 2
EDITING



Cara Menyambung Gambar & Tool Select

a. Cara menyambung Gambar
Ringkasan urutannya adalah sebagai berikut :
1. Buka kedua gambar yang akan digabung, Lalu dikecilkan ukurannya.
2. Salin kedua gambar ke dalam kanvas yang lebar, Muncul sebagai dua
lapis gambar (layer).
3. Geser kedua layer sampai gambar tampak berhimpitan.
4. Sesuaikan kadar cahaya dan warna kedua layer agar serasi.

. Hapus bagian pinggir layer yang berhimpitan.

. Gabungkan menjadi satu layer saja (merge).

. Potong gambar dan ambil area yang bagus saja (crop).

. Kasih teks sebagai tanda tangan (opsional).

. Simpan sebagai file jpeg (jpg).

O 00 N4 O U

Buka kedua gambar dengan menekan tombol Ctrl+O atau pilih menu File
> Open. Atur tampilannya dengan memanfaatkan zoom tool (gambar
kaca pembesar).

£0 0w

(CTRL+0) Open dua file yang mau digabungkan

21



Gabungkan File menjadi 1 di kanvas yang lebih besar, Lalu gabungkan layer

menjadi 1 layer saja (merge).

b. Tool Select

Ps| File Edit Image Layer Type Select Filter 3D View Window Help
All Ctrl+A
v Auto-Select: Laf
LU Deselect Ctrl+D
Untitled-1 @ 25% (Tehillia-615 Reselect Shift+Ctrl+D
o . Inverse Shift+Ctrl+|

O+

All Layers Alt+Ctrl+A
Deselect Layers

Find Layers  Alt+Shift+Ctrl+F
Isolate Layers

Color Range...
Focus Area...
Subject

Select and Mask...  Alt=Ctrl+R
Modify »

Grow

Similar
Transform Selection
Edit in Quick Mask Mode

Load Selection...
Save Selection...

New 3D Extrusion

3,
71
e -
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Tampilan Menu Select pada Photoshop

Dalam menu select, Terdapat berbagai macam perintah yang
berhubungan dengan seleksi. Untuk lebih jelasnya, Mari kita bahas satu-satu.

- All (ctrl + A) : digunakan untuk menyeleksi semua objek.

- Deselect (ctrl + D) : digunakan untuk membatalkan seleksi yang sudah
ada.

- Reselect (shift + ctrl + D) : digunakan untuk menyeleksi kembali daerah
seperti terakhir kali yang dibuat
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- Inverse (shift + ctrl + 1) : digunakan untuk menyeleksi daerah yang tidak
terseleksi, contohnya akan menyeleksi kepala, kalau menggunakan
inverse, maka semua daerah di luar kepala akan terseleksi.

- All Layers (Alt + ctrl + A) : digunakan untuk menyeleksi semua layer.

- Deselect layers : digunakan untuk membatalkan seleksi layer

- Similar layers : digunakan untuk menyeleksi semua jenis layer sesuai
dengan layer yang aktif, contohnya saya menyeleksi semua layer
berupa teks menggunakan similar layers.

- Color range : digunakan untuk menyeleksi sesuai dengan warna yang
dipilih.

- Refine Edge (Alt + ctrl + R) : berisi beberapa menu mengenai modifikasi
area seleksi,feather digunakan untuk memperhalus sudut-sudut area
seleksi.

- Modify : digunakan untuk merubah dan memodifikasi area seleksi
sesuai beberapa pilihan seperti, Border, Expand, Contract.

- Grow & similar : digunakan untuk memperluas area seleksi, namun
dalam grow dan similar, area seleksi akan diperluas berdasarkan
tolerance yang anda atur pada magic wind.

- Transform Selection : Digunakan untuk merubah bentuk area seleksi
yang telah dibuat. Seperti memperbesar, memperkecil, memutar,
mengubah sudut, dan lain-lain.

- Edit in Quick Mask Mode : digunakan untuk mengedit area seleksi
dalam mode quick mask.

- Save selection : digunakan untuk menyimpan seleksi, dan bisa
digunakan kembali dengan menggunakan menu load selection.

Teknik dasar pengaplikasian material pada gambar

A. Pengaplikasian Material
1. Open Image Interior & Masukan ke Workspace
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Open Image Interior anda dengan cara Open (CTRL +0O) dan pilih
gambar yang akan di edit.

2. Atur kompsosisi tone dan warna

Setelah memasukan Image Interior, Atur komposisi warna dengan
Auto Tone, Contrast, Color (Opsional).
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3. Buat Workspace baru sesuai dengan ukuran yang dibutuhkan

Buat Workspace baru dengan ukuran yang dibutuhkan. Lalu pindahkan
Image Interior di jendela workspace sebelumnya ke workspace dengan
ukuran yang dibutuhkan.

4. Masking area yang materialnya akan diubah

Masking area yang akan di ubah materialnya, bisa dengan Magic
Wand Tool , Pen Tool, dan Polygonal Lasoo Tool.
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5. Buka file image material di workspace baru

Open (CTRL+0O) Image Material di Workspace baru. Material bisa di
duplicate sesuai ukuran yang dibutuhkan. Gabungkan layer dari
beberapa layer material menjadi 1 layer (merge). Jika terdapat sisa
workspace yang lebih, Bisa menggunakan crop untuk menghapus sisa
ruang workspace.

6. Copy file dari jendela material ke jendela workspace

Copy Material dari workspace material ke workspace image interior.
Pastikan paste dengan paste special into (CTRL+ALT+SHIFT+V).
Material yang sudah di paste bisa disesuaikan besar material yang
diperlukan. Bisa menggunakan Distort (Edit -> Transform -> Distort).
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7. Catatan
- Saat Masking, pastikan harus rapih dan detail
- Ubah material yang seperlunya saja
- Pastikan menggunakan material dengan ukuran size image yang
high resolution.
- Jangan lupa untuk selalu memberi nama pada layer dan harus jelas.

B. Pengaplikasian Material Furniture
1. Masking Area yang materialnya akan diubah

Masking area yang akan di ubahmaterialnya, bisa dengan Magic
Wand Tool, Pen Tool, dan Polygonal Lasoo Tool.

2. Buka file image material di workspace baru
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Open (CTRL+0O) Image Material di Workspace baru. Material bisa di
duplicate sesuai ukuran yang dibutuhkan. Gabungkan layer dari
beberapa layer material menjadi 1 layer (merge). Jika terdapat sisa

workspace yang lebih, Bisa menggunakan crop untuk menghapus sisa
ruang workspace.

3. Copy file dari workspace material ke workspace image interior

Copy Material dari workspace material ke workspace image interior.
Pastikan paste dengan paste special into (CTRL+ALT+SHIFT+V) ke area
yang di masking. Material yang sudah di paste bisa disesuaikan besar

material yang diperlukan. Bisa menggunakan Distort (Edit -> Transform
-> Distort).

C. Jendela, Tanaman dan Lukisan
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Anda bisa menambahkan Image Jendela, Tanaman, atau Lukisan sesuka
kamu. Dengan Cara Open (CTRL+O) Image di Workspace baru, Lalu copy
image tersebut ke Workspace Interior anda. Anda bisa mengatur besar
kecil gambar tambahan dengan menggunakan Transform.

D. Armature

Pertama, Siapkan ies file lampu yang akan digunakan. Masukan kedalam
workspace interior anda. Anda bisa mengatur besar kecil ukuran lampu
dengan Distort (Edit -> Transform -> Distort). Ubah Blending Modelsnya
menjadi Screen, lalu mainkan opacity dari layer cahaya tersebut.

E. Human

Open (CTRL+O) Image Human, lalu Transform Scale sesuai dengan
kebutuhan. Setelah itu mainkan opacity pada layer human.
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Cara Penyimpanan Gambar

A. Save as PSD

PITTELLLL

Jika kamu menyimpan file dalam bentuk psd. File layer akan bisa diedit
kembali di pembukaan file selanjutnya.

B. Save as PNG / JPEG / PDF

oW
oW
-7
o BE
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Jika kamu menyimpan file dalam bentuk png/ jpeg/ pdf. File layer tidak
akan bisa diedit kembali di pembukaan file selanjutnya.
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Material dan Human Library

Scan disini untuk mendapatkan file material :

[=] 7y,] [=]

[=] Exey

Link : https://qrgo.page.link/aQpHX
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